Chapter 4: Configuring PrintWhere printing options ................................................................. 26
Viewing printer information ........................................................................................................ 27
Configuring paper settings ....................................................................................................... 29
Configuring the Options tab ................................................................................................... 30
  Setting PrintWhere workflow and behavior ........................................................................... 30
  Configuring SSL and proxy server settings .......................................................................... 33
  PrinterOn Account Information .............................................................................................. 35
Updating PrintWhere ................................................................................................................ 35

Appendix A: Glossary of terms ............................................................................................... 36

Appendix B: Troubleshooting PrintWhere .............................................................................. 39
Getting started with PrintWhere

PrintWhere® is a universal Windows print driver that lets you print to any PrinterOn registered printer to which you have access directly from any Windows application.

PrintWhere appears as just another printer that you can choose when you print from any Windows application. However, rather than pointing to a single printer as most printer drivers do, PrintWhere acts as a gateway to the PrinterOn Directory of printers.

You can quickly choose and print to a previously selected printer, or you can search for and connect to a new printer, with no need to install additional printer drivers. Because PrintWhere ties into the PrinterOn service, you can connect and print to printers even when they are not on your local network.

The PrintWhere printing process

In Windows, PrintWhere appears as any other printer. Just like any printer, you can click File > Print and select PrintWhere. Unlike other printers, however, PrintWhere allows you to print to any accessible PrinterOn printer, whether on your local network, or on a remote network.

If an administrator has not already defined a default printer for you, you’ll need to locate and printer before you can successfully print.
You can select a printer at any time, either from the PrintWhere Printer Manager, or during the printing process. Once you associate PrintWhere with a destination printer, you can submit a print job.

When you submit a print job to a printer using the PrintWhere driver, PrintWhere renders the content and passes it on to the PrinterOn service, which then forwards the content to the destination printer. The PrinterOn service can be the publicly hosted service at printeron.com, which allows you to search all PrinterOn registered printers worldwide; or it can be an on-premise version of PrinterOn Enterprise/Express, which restricts your search to those printers within your organization.

PrintWhere monitors the print job and notifies you of changes in its status.

**System requirements**

PrintWhere has the following system requirements:

- Windows 7 or later
- 2GB RAM
- 1GB free disk space (more may be required if a large number of printer drivers are downloaded)

If you are using PrintWhere LE, in addition to the above requirements, you must also install the necessary print drivers on your computer. PrintWhere LE does not install any default drivers.

**PrintWhere installed components**

Once installed, the PrintWhere software includes the following components:

- **PrintWhere Printer Manager**: Lets you locate and select printers registered with PrinterOn. For more information, see Locating and selecting printers.
- **Delivery Options dialog**: Lets you confirm the destination of your print and review the details of your print job. Unless you disable it, this dialog appears every time you submit a print job. For more information, see Confirming your print job.
• **Printer Properties dialog**: Lets you configure printing options to define the print output, PrintWhere behavior, and network communication. For more information, see Configuring PrintWhere printing options.

• **PrintWhere Router**: Lets you monitor and manage the status of your print requests as they are delivered to the specified printers. For more information, see Monitoring and managing print requests.

• **PrintWhere printer drivers**: Generic printer drivers which PrintWhere uses to communicate with the destination printer. The generic printer drivers installed with PrintWhere can communicate with most printers.
Printing with PrintWhere

You print to the PrintWhere driver using the standard Windows printing workflow (typically, File > Print).

By default, PrintWhere does not point to a destination printer; you need to select the destination printer before you can print. If you have a printer that you will typically print to, you can preselect that printer to set it as the default. The first time you print with PrintWhere, the PrintWhere driver directs your print job to that printer. To set a default printer, see Locating and selecting printers.

You can locate and choose your printer at the time of printing. If you need to change your printer for any reason, you can locate and choose another printer from the PrinterOn Directory at any time. The most recently used printer is always selected by default the next time you submit a print job.

To print using the PrintWhere Printer Driver:

1. In your Windows application, select File > Print.
2. In the Print dialog, choose PrintWhere <version> as your printer.

Important! Ensure that you choose PrintWhere <version>, and not PrintWhere Plug-in xxxx, if one or more are listed. These plugins are simply helper printer objects created by PrintWhere when you choose a new destination printer to allow the computer to access the required printer driver.
3. Modify the printing preferences as necessary. The Printing Properties dialog allows you to:
   • change your printer and view detailed printer and printer location information
   • set paper and duplex settings
   • define PrinterOn system-specific settings and provide account information.

4. Click Print.

5. If the Delivery Options dialog appears, confirm the delivery options, then click OK.

   Note: If you receive a release code, take care to make note of it. You may need this code to release your print job at the printer.

6. If necessary, provide any additional required input, such as authentication credentials or payment information. PrintWhere prompts you for any additional input.

   Note: In some cases, PrintWhere may redirect you to a browser form to authenticate against an Identity Management Service. You will be unable to interact with PrintWhere while it awaits confirmation that you were successfully authenticated.

   If you fail to authenticate within a designated timeout period, the print request fails, and PrintWhere becomes active again.

   In rare cases, authentication may fail even after you receive a message indicating you have successfully authenticated. This is typically due to a network issue blocking a necessary second communication with the authentication server.

7. If necessary, release the job to the printer using the release code that was provided in the Delivery Options dialog.

Once the job is submitted, you can monitor your print job to view the status, pause, resume, restart, or cancel it.
Confirming your print job

The Delivery Options dialog lets you to confirm the destination of your print and review the details of your print job. Unless you disable it, this dialog appears every time you submit a print job. The Delivery Options dialog displays up to three tabs:

- **Job Details**: Displays information about the job, including job summary, release information, printer information, and the selected print options for the job. For more information, see Viewing job details.

- **Options and Info**: Lets you enter information to be added to a print job’s cover page, if enabled, and provides additional instructions or important information supplied by the printer owner. For more information, see Adding cover page information.

- **Cover Page Preview**: Displayed only when a cover page is added to the print job, this tab lets you preview the content of the cover page.

Viewing job details

The **Job Details** tab of the Delivery Options dialog displays information about the print job.
The job summary highlighted at the top of the tab displays the printer name, the number of pages, the unique reference number of the print job (for tracking purposes) and the type and name of the document. The Job Status field indicates the progress of the job processing. Once the document is ready, you can click OK.

**Note:** A Ready status does not indicate that the printer is operating correctly, only that the PrinterOn server can accept and hold a job prior to releasing to the printer.

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Privacy Release</td>
<td>Displays the secure Privacy Release Code for the job. Depending on your destination printer, you may be prompted to enter this information before the job is printed, or it may be generated automatically for you.</td>
</tr>
<tr>
<td>Printer Information</td>
<td>Displays a summary of the selected printer for the current print request.</td>
</tr>
<tr>
<td>Job Information</td>
<td>Displays information about the print job and printer settings that may affect the output of the job such as Color, Paper Size, or Duplex options.</td>
</tr>
</tbody>
</table>
Adding cover page information

The **Options and Info** tab lets you enter information to be added to a print job’s cover page, if enabled. It also provides additional instructions of important information supplied by the printer owner.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Deliver To</strong></td>
<td>Your name or other identification to be added to the print job’s cover page to identify you as the owner of the print job. This field is only enabled if a cover page is enabled for the print job.</td>
</tr>
<tr>
<td><strong>Comments</strong></td>
<td>Comments or instructions to be added to the cover page. This field is only enabled if a cover page is enabled for the print job.</td>
</tr>
<tr>
<td><strong>Instructions</strong></td>
<td>Instructions supplied by the printer owner for users. For example, the printer owner may provide details about when a document can be picked up or how it can be delivered.</td>
</tr>
</tbody>
</table>
Monitoring and managing print requests

The PrintWhere Router window lets you monitor and manage the status of your print requests as they are delivered to the specified printers. The Router displays information about the type and size of the document sent, the printer it is being sent to after being released from the server, and the portion of the print request that has already been sent.

![PrintWhere Router window](image)

**Note:** If you shut down your computer or close the PrintWhere Router while it is sending documents, the unfinished jobs will resume automatically when you restart your computer or open the Router.

To monitor your print jobs:

1. Double-click on the 📥 icon in your system tray.

   The PrintWhere Router appears, displaying the following information for each active print request:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Document Name</strong></td>
<td>The name of the document being transmitted. You can hide the names of your documents and replace the name in the router with the PrinterOn Transaction ID (see figure).</td>
</tr>
<tr>
<td><strong>Status</strong></td>
<td>The current delivery status of the job.</td>
</tr>
<tr>
<td><strong>% Sent</strong></td>
<td>The amount of data delivered to date.</td>
</tr>
<tr>
<td><strong>Pages</strong></td>
<td>The number of pages included in the print job.</td>
</tr>
<tr>
<td><strong>Size</strong></td>
<td>The size of the entire document (for example, 500KB).</td>
</tr>
<tr>
<td><strong>Submitted</strong></td>
<td>The date and time that the print request is made.</td>
</tr>
<tr>
<td><strong>Destination</strong></td>
<td>The PrinterOn ID of the destination printer (for example corp-acme-accounting).</td>
</tr>
</tbody>
</table>
2. If necessary, select a print job, then open the Document menu and perform one of the following actions:

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Pause** | Makes a print request ineligible for printing. You can pause print requests with the following status:  
  - **Pending**: The status changes to **Paused**, and the request is not sent to the printer until it is resumed or restarted.  
  - **Printing**: The status changes to **Printing–Paused**.  
  - **Printing–restarting**: The status changes to **Printing–Pausing**.  
  The router cannot pause a printing job if all the data has been transmitted. |
| **Resume** | Makes a paused print request eligible for printing. The print request status changes from **Paused** or **Printing–Pausing** to **Pending**. The print request is then eligible for printing, but may not be the next job printed. |
| **Restart** | Stops a print request with a status of **Printing** and restarts it. The function can only stop the print request if all the data has not already been transmitted. The print request returns to the **Pending** state. It may not be the next job printed. |
| **Cancel** | Deletes the selected print request from the PrintWhere Router. You can cancel print requests with the following status:  
  - **Paused**  
  - **Pending**  
  - **Printing**  
  - **Printing–Pausing**.  
  If the router shows that the entire document has been sent, you cannot cancel the print job. |
Locating and selecting printers

PrintWhere includes a Printer Manager application to help you search for, locate, and select a printer.

You can access the Printer Manager in a number of ways:

- Clicking Start > PrintWhere Printer Manager.
- Clicking in the system tray.
- Double-clicking the desktop icon.
- Clicking Find a Printer from the PrintWhere Printer Preferences dialog, which you can access from any Windows Print dialog.
Locating and selecting printers

Discovering and selecting printers

To locate and select a printer:

1. In the PrintWhere Printer Manager window, find a printer by
   • Performing a basic keyword search, which lets you search for a printer name or organization name, for example.
   • Performing an advanced search, which lets you provide additional criteria to further limit the number of printers returned.
   • Clicking the History tab and choosing a previously selected printer from the list.

2. When you find the printer you want, select it, then click OK. The Confirm Printer Selection dialog appears.

   ![](image.png)

   Note: Click Details to get additional information about the printer.

3. Once the Printer Status changes to Destination Ready, click Select.

   PrintWhere updates your printer selection. The printer is also added to the History list. This printer will be used by default next time you print from your applications.
Performing a basic keyword search

A basic keyword search lets you search the PrinterOn Directory based on one or more keywords you provide.

**Note:** You can limit the number of search results that are returned by configuring search filters in the Search Preferences dialog. For example, if you provide an organization name, results are filtered to include only those printers that are registered to that organization. Search preferences are applied to every basic keyword search.

For more information, see Configuring printer search filters.

To perform a keyword search:

1. Enter one or more keywords in the **Keywords** field.

   ![PrintWhere Printer Manager](image)

   **Note:** If you are using PrinterOn Enterprise/Express, you can return all available printers by leaving the **Keywords** field empty.

2. If you want to limit the search results to printers that require your authentication credentials, check **Private Printers Only**.

   **Note:** If you check **Private Printers Only**, you must specify your access credentials in the Search Preferences for the Printer Manager to return any results. For more information, see Accessing secured printers.

3. Click **Search**. The Printer Manager queries the PrinterOn directory and displays results in the **Search Results** tab.
Performing an advanced search

The Advanced Search dialog lets you be more specific about your search criteria, so that you can restrict which printers are returned in your search results.

**Note:** An advanced search ignores any preferences that you have specified in the Search Preferences dialog.

To perform an advanced search:

1. In the PrintWhere Printer Manager, click **Advanced**. The Advanced Search dialog appears.

2. Use the **Category** selection to limit the type of printers to include in a search request. Options include:

<table>
<thead>
<tr>
<th>Category Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All</td>
<td>Any printer in the PrinterOn Directory.</td>
</tr>
<tr>
<td>Public</td>
<td>Printers that are available to the general public.</td>
</tr>
<tr>
<td>Organization</td>
<td>Printers that are part of a PrinterOn Enterprise or PrinterOn Business service.</td>
</tr>
</tbody>
</table>
3. Select which printing features you want your destination printer to have.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paper</td>
<td>The paper size you want to print to.</td>
</tr>
<tr>
<td>Duplex</td>
<td>The duplex option you want to use.</td>
</tr>
<tr>
<td>Privacy</td>
<td>Whether the printer should require you to enter a release code before the job is printed.</td>
</tr>
<tr>
<td>Color</td>
<td>Whether the printer should support color or only Black and White.</td>
</tr>
</tbody>
</table>

4. Enter search criteria that will be used to filter search results based on the information supplied.

<table>
<thead>
<tr>
<th>Criteria</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Keywords</td>
<td>One or more descriptive words to search for.</td>
</tr>
<tr>
<td>Organization</td>
<td>The name of an organization or company, as configured in the PrinterOn Directory, that the printer must belong to.</td>
</tr>
<tr>
<td>City</td>
<td>The city name where the printer must be located.</td>
</tr>
<tr>
<td>State</td>
<td>The state or province where the printer must be located.</td>
</tr>
<tr>
<td>Country</td>
<td>The country in which the printer must be located.</td>
</tr>
<tr>
<td>Private Printers Only</td>
<td>When checked, search results only include printers that have control access, and are accessible using the Account Information supplied in the Search Preferences dialog. For more information on specifying account information, see Accessing secured printers.</td>
</tr>
</tbody>
</table>
Managing printer lists

The Printer Manager lets you:

- specify how to sort printers in the History and Search Results lists.
- clear the History list.

Sorting printers

For the printers listed in the History and Search tabs, you can sort your printers in a number of ways.

To sort printers:

1. From the Order By drop-down, choose how printers are sorted:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Most Recently Used</td>
<td>Displays the printers in the History tab in the order they were used. This is the default.</td>
</tr>
<tr>
<td>Organization</td>
<td>Lists the printers alphabetically according to the name of the organization that owns the printer.</td>
</tr>
<tr>
<td>Printer Name</td>
<td>Lists the printers alphabetically according to the name of the printer.</td>
</tr>
<tr>
<td>Price</td>
<td>Lists the printers according to the cost of printing, from lowest to highest. Free printers are listed first.</td>
</tr>
<tr>
<td>Allowed Pages</td>
<td>Lists the printers according to the number of pages you are allowed to print. If no number is present, there is no limit.</td>
</tr>
</tbody>
</table>

Clearing the History list

The History tab displays a list of printers that you have previously selected. You can clear this list of all printers.

To clear the History list:

1. In the PrintWhere Printer Manager, click Search Preferences.
2. In the PrintWhere Search Preferences dialog, click Clear History.
3. On the Confirmation dialog, click OK.
4. Click OK.
Setting printer search preferences

Clicking **Search Preferences** in the Printer Manager displays the Search Preferences dialog.

![Search Preferences dialog](image)

This dialog lets you manage various search settings. From this dialog, you can:

- Define search filter criteria.
- Specify a different service URL to search a private printer directory.

Configuring printer search filters

Because the PrinterOn Directory contains every printer registered with PrinterOn, certain keywords may yield a very large number of printers. To restrict search results without performing an advanced search every time, the Search Preferences dialog lets you configure some basic filters to narrow the list of search results to a more manageable number.

For example, to restrict the results to your organization, you can provide the organization name. In a multinational organization, you could further restrict results to a particular geographic location. The information you supply in PrintWhere is compared to the information that was configured by the printer owner or administrator.

Filter settings are applied to every basic keyword search. You can override the filter settings by performing an advanced search.
To set printer search filters:

1. In the PrintWhere Printer Manager window, click **Search Preferences**.
2. In the **Search Using** section of the Search Preferences dialog, define your filter criteria:

<table>
<thead>
<tr>
<th>Filter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Organization</td>
<td>The name of a company, as provided in the Printer Listings.</td>
</tr>
<tr>
<td>Address</td>
<td>Any part of address information (state, city, street, zip code, etc.) that you provided in your Printer Listings</td>
</tr>
<tr>
<td>Category</td>
<td>The type of PrinterOn printer to filter. Options include All printers, PrinterOn Public printers and printers within your Organization. Organization printers include PrinterOn Business or PrinterOn Enterprise printers</td>
</tr>
</tbody>
</table>

### Accessing secured printers

If you have permission to use secured printers, you must provide the necessary **service URL** and **account information** to allow PrintWhere to search for and access them. A secured printer might be:

- a private printer within an enterprise that is only accessible to users within the firewall
- a public printer with restricted access, such as a printer at a hotel that is available only to hotel guests

**Note:** If PrintWhere was configured for you by an administrator, it may not be possible to change your Service URL or account information without their assistance.
Setting a custom service URL

The Service URL identifies the address of the PrinterOn service that hosts the PrinterOn Directory of printers, which PrintWhere searches to locate printers that match your criteria.

By default, PrintWhere searches the public directory hosted at printeron.com, which contains all registered PrinterOn printers worldwide. However, organizations with an on-premise solution, such as PrinterOn Enterprise or PrinterOn Express, maintain a private directory of their own printers.

If your organization has an on-premise installation, this value must be explicitly set and must match the Service URL that the PrinterOn Server uses so you can search your private PrinterOn Directory for your organization’s printers. An administrator may have pre-defined this value for you. If it has not already been set, you must manually configure this value yourself.

When configured, PrintWhere will use the Service URL for all communication with the PrinterOn server, including:

- Searching for printers
- Delivering print jobs to destination printers
- Reporting and logging
- Retrieving printer configuration information

If you need to locate a public printer (for example, if you are traveling and need to use a hotel printer), you can clear your private Service URL and access the public PrinterOn Directory to search for and locate the printer at your hotel. You must make sure you reconfigure your private Service URL when you’re back on your organization’s network.

**Note:** Only printers that are associated with the currently specified Service URL are accessible. If you select a printer from the public Service URL, then change to a private Service URL, you can no longer print to the printer associated with the public Service URL.
To set a custom URL to support an on-premise version of PrinterOn:

1. In the PrintWhere Printer Manager window, click **Search Preferences**.

![Search Preferences dialog](image)

2. In the **Service URL** section of the Search Preferences dialog, enter the host name or IP address of the server hosting your PrinterOn service.

3. Click **OK**.

**Providing and managing account information**

Use of some printers may be restricted. Depending on the how access to the printer is configured, different account information may be required:

- In some print workflows, you may be required to supply your Windows account information to submit a print job. PrintWhere automatically extracts your username and includes this information with print jobs when required. The **System Login ID** value indicates the operating system defined login identifier for jobs.

- Some workflows may be configured to use a corporate LDAP/AD server or some other Identity Management Service for access control. In this case, you must provide the credentials for that server/service. You can provide your account information in the **Account Settings** dialog, and PrintWhere will pass those credentials to the authentication service on your behalf.

**Note:** If you are using PrinterOn Enterprise or PrinterOn Express, you **must** enter the PrinterOn Server’s Service URL before you provide your user credentials. When you provide user credentials, PrintWhere immediately tries to contact the PrinterOn Server to validate them. Without the Service URL, PrintWhere can’t contact the server and validation fails.
• In other workflows, the printer may be tied to a third-party print management system that may request some additional custom data, like a custom PIN value or release code, before the document can be printed. In these cases, PrintWhere saves the data and will provide it to the printer on your behalf for future print jobs. You can clear this data at any time. For more information, see Clearing saved third-party data.

To provide your user credentials:

1. In the PrintWhere Printer Manager window, click **Account Settings**. The Account Settings dialog appears.

2. This dialog differs depending on the Authentication service your organization uses.


   This dialog differs depending on the Authentication service your organization uses.

4. Enter your **Username** and **Password**.

5. Click **OK**.

6. To make sure you entered your account information correctly, click **Validate** to validate your credentials against the server.

   **Note:** If you are using PrintWhere in a public environment, such as a kiosk, you should clear your User Information at the end of your session. For more information, see Clearing the current account information.

7. Click OK to close the **Account Settings**.
Clearing the current account information

If you are using PrintWhere in a public environment, such as a kiosk, you should clear your account information at the end of your session.

To clear account information:
1. In the PrintWhere Printer Manager window, click Account Settings.
2. In the Account Settings dialog, click Clear Credentials.
3. Click OK to return to the PrintWhere Printer Manager.

Clearing saved third-party data

In some cases, PrintWhere stores information that you enter to interact with a third-party print management system. For example, some printers may request that you enter a custom PIN or release code in order to release a document. This same code is can be used to release subsequent print jobs. PrintWhere saves these codes, and submits them on your behalf the next time you print to that printer.

You can clear these codes at any time from the Account Settings dialog; if PrintWhere has saved some third-party data, a Clear-Third-Party Data button appears in the dialog.

Once this data is cleared, the next you printer to that printer, you can supply a new value, which PrintWhere will again save for future use.

To clear saved third-party data:
1. In the PrintWhere Printer Manager window, click Account Settings.
2. In the Account Settings dialog, click Clear Third-Party Data.
3. Click OK to return to the PrintWhere Printer Manager.
Configuring PrintWhere printing options

PrintWhere lets you configure a number of printing options to define the print output, PrintWhere behavior, and network communication.

To configure PrintWhere printing options:

1. Open the PrintWhere Printing Properties dialog:
   - In the Windows Printers folder, right-click PrintWhere <version> and select Printing Preferences.
   - From the application's Print window, select PrintWhere <version> as your printer, then click the Preferences button.

   **Note:** When using the Chrome browser, you must select Print using system dialog to be able to access the Preferences.

   **Note:** When choosing PrintWhere as your printer, make sure you choose PrintWhere <version>. Do not choose PrintWhere <version> Plug-in nnnn. This plug-in is merely an artifact PrintWhere creates to contain the specific printer driver required for a previously selected printer.
2. Configure the settings on the following tabs:
   - **Printer**: Specifies the destination printer and printer details. You can also change the destination printer from this tab.
   - **Paper**: Specifies a number of basic page setup options.
   - **Options**: Specifies additional PrintWhere settings or network communication settings.

3. Click **OK**.

**Viewing printer information**

The **Printer** tab provides information about the printer you are sending your document to. This tab also lets you select a previous printer, or access the Printer Manager to choose a new printer.
## Configuring PrintWhere printing options

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
</table>
| Printer   | Specifies the destination printer. To change the printer:  
  - Manually enter the PrinterOn ID or Printer Number.  
  - Select a recently used printer from the drop-down list.  
  - Click **Find a Printer** to open the Printer Manager and search for a printer in the Directory. For more information, see **Locating and selecting printers**. |
| Status    | Indicates whether the printer is **Online** and ready to be used, or **Offline** for maintenance.                                           |
| Connection| Indicates whether the printer is located on the Internet or on a local network.                                                                |
| Company   | The name of the company who owns the printer, as described by the administrator in the printer’s Directory listing.                        |
| Vicinity  | The specific location of the printer, such as ‘Front Desk’ or ‘Accounting department’.                                                      |
| Description| A brief description of the printer, provided by the printer administrator. The description may explain what kind of printer it is, how the printer can be accessed, or how should be used. For example, the description might read **Color laser** or **Release Code required for document pick up**. |
| Options   | Describes any restrictions on printing, such as the maximum number of pages, or whether color printing is permitted.                         |
| Model     | The manufacturer, make and model of the printer.                                                                                           |
| Details   | When clicked, opens the Printer Details window, which provides a complete description of the printer as provided by the printer owner. This additional information may include such information as duplexing options or pricing information. |
Configuring paper settings

The **Paper** tab lets you specify a number of basic page setup options.

To modify the PrintWhere options:

1. In the PrintWhere Properties dialog, click the **Paper** tab.
2. From the **Size** drop-down, choose the size of the paper you want to print to.

   **Note:** The owner of the printer specifies which paper sizes are supported. If the printer owner has not specified any paper sizes, the default is Letter (8 1/2 x 11 in).

   Your paper size choices are limited to this list as dictated by the printer owner. Although the Advanced properties dialog may offer additional paper sizes, if those additional paper sizes are not enabled by the printer owner, PrintWhere cannot print to them.

3. Specify whether to print the document in **Landscape** or **Portrait** orientation.
4. If enabled, choose a duplex option. Choices vary depending on which options the printer owner configured for the printer. Duplex options can include:
   - Single Sided Only (Simplex)
   - Double Sided Only (Duplex)
   - Default to Single Sided: When duplex is also available, but is not selected.
   - Default to Double Sided: When simplex is also available, but is not selected.
   - Not Managed: The printer owner has placed no restrictions on the Duplex feature. Depending on the printer, duplexing may be still available in the Advanced printer driver properties.

5. Specify whether you want to print in color or in black and white.

6. To modify other available printer driver properties, click Advanced. Depending on the print data generator associated with the printer, various additional options may be available.

**Note:** In some cases, the PrintWhere Paper settings may override similar printer driver properties.

### Configuring the Options tab

From the **Options** tab, you can:

- configure PrintWhere workflow and behavior.
- configure network communication settings.
- change your account information.

### Setting PrintWhere workflow and behavior

PrintWhere provides a number of options that allow you to customize your print workflow or to provide compatibility with certain printers. These options do not generally need to be modified.

To modify the PrintWhere options:

1. In the PrintWhere Properties dialog, click the **Options** tab.
2. Click the **PrintWhere Settings** button. The PrintWhere settings dialog appears.

![PrintWhere Settings Dialog](image)

Settings are organized into three sections:

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print Confirmation Dialog</td>
<td>Define the behavior of the confirmation dialog that displayed by PrintWhere during the print process.</td>
</tr>
<tr>
<td>Processing Settings</td>
<td>Define the behavior of PrintWhere when configuring or processing print jobs.</td>
</tr>
<tr>
<td>General Settings</td>
<td>Define general PrintWhere behavior.</td>
</tr>
</tbody>
</table>

3. Configure the settings as necessary, then click **OK**.

**Print Confirmation Dialog settings**

The following settings affect the behavior of the confirmation dialog presented by PrintWhere during the print process.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Only Display When Required</td>
<td>When enabled, the Print Confirmation dialog only appears if user input is required.</td>
</tr>
</tbody>
</table>
Configuring PrintWhere printing options

### Job Processing Settings

The following settings affect the behavior of PrintWhere when configuring or processing print jobs.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Enable Privacy Release</strong></td>
<td>When enabled, a reminder message appears when the printer requires a release code to access a print job. The prompt is displayed after accepting and closing the confirmation dialog.</td>
</tr>
<tr>
<td><strong>Allow non-PrinterOn Drivers</strong></td>
<td>When enabled, PrintWhere searches the local PC for a compatible print driver before downloading components from the PrinterOn web services. PrintWhere is capable of downloading additional driver components to support a particular printer. When you select a new printer, PrintWhere can check whether the print driver is already installed on the PC.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Enable Plugin Caching</strong></td>
<td>When Enable Plugin Caching is enabled, PrintWhere maintains multiple PrintWhere printer plugins. You cannot change this setting. If necessary, an administrator can update the registry to enable plugin caching.</td>
</tr>
<tr>
<td><strong>Use Alternate Duplex</strong></td>
<td>When enabled, PrintWhere uses alternate duplex options. In many environments, PrintWhere informs the printer whether to print a print job as duplex and uses the most compatible solution to provide duplex options. If you encounter problems receiving duplex output, you can try the alternate duplex options. This option should only be changed if you are encountering problems printing.</td>
</tr>
</tbody>
</table>
Configuring PrintWhere printing options

General Settings

The following settings affect the overall behavior of PrintWhere when printing.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hide Document Name</td>
<td>When enabled, the name of the document is replaced by the unique reference number for the print request.</td>
</tr>
<tr>
<td>Enable Kiosk Mode</td>
<td>When enabled, PrintWhere doesn’t store user or account information entered by the user. This is recommended when deploying PrintWhere in a public location or kiosk.</td>
</tr>
<tr>
<td>Anonymous Job Reporting</td>
<td>When enabled, PrintWhere removes all user identifying information that may be reported to PrinterOn. Information included in reports to PrinterOn is typically used to provide auditing or tracking services for the printer owner.</td>
</tr>
</tbody>
</table>
| Minimal Job Data Reporting     | When enabled, PrintWhere removes document related information sent to PrinterOn. This includes information such as file sizes and file extensions.  
**Note:** The information supplied when this option is not enabled is used for analytic purposes only. |

Configuring SSL and proxy server settings

If your environment requires the use of a proxy server or self-signed certificates for facilitating secure communication, you may need to configure network settings so that PrintWhere can successfully deliver print jobs to the printer.

To configure network settings:

1. In the PrintWhere Properties dialog, click the **Options** tab.
2. Click the **Network Settings** button. The Network Settings dialog appears.

3. To enable PrintWhere to communicate with services that use self-signed certificates for HTTPS communication, check **Disable SSL Certificate**.

4. If your PrinterOn service uses a proxy server, enable one of the following settings:
   - **Web Proxy Auto-Discovery (WPAD)**: Enable this setting if your administrator has set up WPAD.
   - **Enable Manual Proxy Configuration**: Enable this setting to manually configure the proxy server location.

   **Important!** Contact your administrator before enabling this setting.

5. Configure the following proxy server settings as necessary:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Proxy Server</strong></td>
<td>The proxy server address used by PrintWhere. Include the server IP/address and the port number in this field (for example, 192.168.1.1:800).</td>
</tr>
<tr>
<td><strong>Windows NTLM</strong></td>
<td>When checked, PrintWhere uses NTLM for proxy authentication. Otherwise, PrintWhere uses Basic proxy authentication.</td>
</tr>
</tbody>
</table>
6. Click OK.

### PrinterOn Account Information

The **PrinterOn Account Information** section lets you access the Printer Manager so you can update your account settings, if necessary.

Click **Printer Manager** to open the Printer Manager, then modify your account settings as described in Providing and managing account information.

### Updating PrintWhere

To ensure that you have the latest PrintWhere features, PrintWhere alerts you when a new version is available on our web site.

To upgrade PrintWhere:

1. In the PrintWhere Properties dialog, click the **About** tab.
2. Click the **Upgrade now!** button, which appears if a newer version exists.
Glossary of terms

Cover Page

An option set by the printer owner that determines whether or not the user will be required to print a cover page. By default, cover pages include: the printer address, the sender's name, the reference number of the print request, and the number of pages. Users can add the recipient name and additional comments when they send their documents.

Encryption

Encryption is the translation of data into a secret code. Encryption is the most effective way to achieve data security. To read an encrypted file, you must have access to a secret key or password that enables you to decrypt it.

PrinterOn uses public-key, or asymmetric, encryption, a cryptographic system that uses two keys: a public key, known to everyone; and a private or secret key, known only to the recipient of the message. When John wants to send a secure message to Jane, he uses Jane's public key to encrypt the message. Jane then uses her private key to decrypt it.

An important element of the public key system is that only the public key can be used to encrypt messages and only the corresponding private key can be used to decrypt them. Moreover, it is virtually impossible to deduce the private key if you know the public key. Public-key systems are becoming popular for transmitting information via the Internet. They are extremely secure and relatively simple to use.
The setting is also determined by whether the printer owner has attached the printer to a Print Delivery Station server and how the encryption setting in the server is configured. If the printer or server at the other end of the transmission does not support our encryption service, the print request will be sent unencrypted.

When you confirm your print job prior to printing, the Job Information tab describes the encryption setting, which will use one of the following labels: None, Not supported by destination, Enable.

**Internet Protocol**

Internet Protocol (IP) specifies the format of packets, also called datagrams, and the addressing scheme. Most networks combine IP with a higher-level protocol called Transport Control Protocol (TCP) which establishes a virtual connection between a destination and a source.

**IP Address**

This is the unique Internet Protocol address for a device on the Internet, identifying the network and device transmitting the information. Usually expressed as four decimal numbers, IP addresses can either be static, or randomly assigned from one session to the next.

**IPP/Internet Printing**

The Internet Print Protocol (IPP) is a sanctioned Internet Engineering Task Force (IETF) standard for printing documents over the web. IPP defines basic handshaking and communication methods, but does not enforce the format of the print data stream. Typically, a standard page description language, such as HP PCL or Adobe PostScript, would be used.

**Printer Number**

A Printer Number is a unique 12 digit number people can use to find your printer in the PrinterOn Directory. Every printer added to the PrinterOn Directory is given a Printer Number to make it easy for people using mobile devices, such as cellular phones or tablets, to find and use a printer. A Printer number follows the format: ###-###-###-### or ############.
**PrinterOn ID**

A unique, logical printer address that will be used to access the printer in the Printer Directory from PrinterOn products and services. The PrinterOn ID is a fixed address that is used to identify the printer, enabling you to change the physical location, or even the make and model of your printer.

**Privacy Settings**

A description in the PrintWhere Job Information tab that explains how the print job will be released to the user. The printer may be operated by an attendant, the print job may be released automatically, or the print job may require the user to enter information to release the print job.

**Service URL**

The Service URL is the location of your PrinterOn service. PrintWhere connects to this URL to access the PrinterOn directory. The Service URL also manages all printing communication; PrintWhere submits print jobs to the PrinterOn service URL, which then forwards the job to the destination printer.

By default, PrintWhere points to the Service URL for PrinterOn Hosted, which is publicly available to all PrinterOn users. You may need to change the Service URL the PrintWhere connects to, however. If your organization hosts its own PrinterOn Enterprise or PrinterOn Express solution, you should modify the URL to point to your private PrinterOn service.

**URI**

Uniform Resource Identifier, the generic term for all types of names and addresses that refer to objects on the World Wide Web. A URL is one kind of URI.
Troubleshooting PrintWhere

Locating PrintWhere log files

Should you have problems printing with the PrintWhere universal printer driver, you may need to access the PrintWhere log files to help diagnose the problem.

PrintWhere saves log information to the following files:

- On Windows versions earlier than Windows 10:
  C:\ProgramData\PrinterOn Corporation\PONData\Logs\PrintWhere <version>\<log_name>.log

- On Windows 10:
  C:\Users\<user>\AppData\Local\PrinterOn Corporation\PrintWhere <version>\<log_name>.log

Problems associated with the installation or uninstallation of PrintWhere are saved to the following log files:

- Uninstalling the previous version:
  C:\Program Files\PrinterOn Corporation\pwcInstall<previous_version>.log

- Installing the current version:
  C:\Program Files\PrinterOn Corporation\pwcInstall<current_version>.log.

- Windows Installation file:
  C:\Users\<user>\AppData\Local\Temp\MSI*.log.
Determining which PrintWhere edition you have installed

You can determine which edition you have installed by viewing the About dialog. The About dialog displays version information about PrintWhere and lists the printer drivers that were installed with the PrintWhere software.

If there are no drivers listed, then PrintWhere LE was installed. Otherwise, the full version of PrintWhere was installed.

To view the About dialog:

• In the Printer Manager, click the Information icon.

The About dialog appears.
Trademarks and service marks

The following are trademarks or registered trademarks of PrinterOn Inc. in Canada and other countries:

PrinterOn®, PrintAnywhere®, Print Simply Anywhere®, PrintWhere®, PRINTSPOTS®, the PrinterOn Logo, the PrinterOn Symbol, PrintConnect™, Secure Release Anywhere™, and PrintValet™ are trademarks and/or registered trademarks of PrinterOn.

The following are trademarks or registered trademarks of other companies:

Windows, Internet Explorer, Microsoft Word, Microsoft Excel, Microsoft PowerPoint, and Microsoft Visio are trademarks or registered trademarks of Microsoft Corporation.

iPad, iPhone, AirPrint, and macOS are trademarks or registered trademarks of Apple.

iOS is a trademark or registered trademark of Cisco in the U.S. and other countries and is used by Apple under license.

Android, Chrome OS, and Chromebook are trademarks or registered trademarks of Google Inc.

BlackBerry is a registered trademark of BlackBerry, Ltd.

Other brands and their products are trademarks or registered trademarks of their respective holders.

Copyright notice

© Copyright 2020 by PrinterOn Inc.

All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or transmitted, in any form or by any means, electronic, mechanical, photocopy, recording, or otherwise, without the prior written permission of PrinterOn Inc.

Disclaimer:

PrinterOn Inc. makes no warranty with respect to the adequacy of this documentation, programs, or hardware, which it describes for any particular purpose, or with respect to the adequacy to produce any particular result. In no event shall PrinterOn Inc. be held liable for special, direct, indirect, or consequential damages, losses, costs, charges, claims, demands, or claim for lost profits, fees, or expenses of any nature or kind.

Version 6.2.6 | March 24, 2020